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Welcome

Avenza welcomes you to mapmaking in the 21st century!

Combined with Adobe Illustrator, MAPublisher has revolutionized the art of mapmaking by allowing spatial data
files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to
be performed where they should be done; in a powerful graphics environment.

MAPublisher LabelPro™ revolutionizes the way users can label map data, including using symbols as labels, conflict
resolution, and highly configurable rule-based labeling options. The MAP LabelPro engine uses map data attributes
for labeling with styles, rules and controls configured through an intuitive, easy-to-use Graphical User Interface.

This tutorial assumes that the user is familiar with Adobe Illustrator CS5/CS5.1/CS6, and has at least a basic
understanding of MAPublisher tools and features. Not all MAPublisher tools are explained in this document. This
tutorial should be used in conjunction with the MAPublisher 9 User Guide, MAPublisher 9 Tutorial Guide and Quick
Start Guide for an understanding of all the other MAPublisher tools.

By following this tutorial, you will learn how to setup and use the MAP LabelPro labeling engine to label your

map created in MAPublisher. Working on a provided map, users learn to create rules and styles for labeling in an
automated and efficient way.

MAP LabelPro Tutorial Data

This tutorial will use Adobe lllustrator files and MAP LabelPro rules installed with MAPublisher 9. You can find the
MAP LabelPro Tutorial data in the following location on your hard drive:

Windows XP
C:\Documents and Settings\All Users\Shared Documents\Avenza\MAPublisher 9\MAP LabelPro Tutorial & Data\Data

Windows Vista and Windows 7
C:\Users\Public\Public Documents\Avenza\MAPublisher 9\MAP LabelPro Tutorial & Data\Data

Note: This data may be accessed through shortcuts available in the Windows start menu

Mac0SX
/Applications/Avenza/MAPublisher 9/MAPublisher Tutorials/MAP LabelPro Tutorial & Data/Data

You are encouraged to experiment with your own data to gain additional experience with MAPublisher tools.

Tutorial data courtesy of City and County of San Francisco (San Francisco Enterprise GIS program SFGIS).

MAPublisher 9 LabelPro Tutorial il
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1.1 Purpose

1 Preliminaries

The purpose of this exercise is to use MAP LabelPro to create labels for a simple map of downtown San Francisco,
California, USA. For this exercise, Avenza has prepared the necessary map file created with MAPublisher 9 and Adobe
lllustrator, based on City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS). The map
contains all the different type of features (point, line and area) for labeling and/or obstacle purpose.

In this exercise, you will start by preparing the file and examining the data to familiarize yourself with the
prerequisites to using MAP LabelPro. Then, the labeling will be done in two steps: a main labeling session (labeling
public schools, streets, interstates, highways and land areas in one run) and a secondary session (labeling parks
only, using the other labels as obstacles). Although the presented settings are valid only for the map data they are
based on, the principles are applicable for your own designs.

1.2 Know your data

The MAP LabelPro Tutorial data folder contains a ready-to-use Adobe lllustrator template file containing a map of
downtown San Francisco (MAPLabelPro_Tutorial.ait). Here is a description of the layers present in the file and how
they will be used during the labeling process.

1.2.1 San Francisco map description

Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2
Text layers
LAND_labels Text Land labels - - No
SCHOOL_labels Text School labels - - Yes
STREET _labels Text Street labels - - Yes
PARK_labels Text Park labels - - -
HIGHWAY_INTERSTATE_labels | Text Labels for highways and interstates | - - Yes
SUPPRESSED_labels Text Labels that couldn't be placed - - No
based on the specified rules.
MAP_TITLE Text Map title (San Francisco) - Yes No
MAP Layers
Public_Schools_point Point Public school locations SCHOOL_NAME Yes Yes
Post_Offices_point Point Post office locations - Yes Yes
Highways_line Line Highway roads HIGHWAY_NUMBER Yes Yes
Interstates_line Line Interstate roads INTERSTATE_NUMBER | Yes Yes
Ramp_line Line Ramps to highways - No No
Streets_line Line San Francisco street network STREETNAME No No
Land_area Area Land areas AREA_NAME No No
Parks_area Area Park areas PARK_NAME Yes No

MAPublisher 9 LabelPro Tutorial
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Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2

Other Layers
Scale_Bar Legend | Scale bar - -
background Area Blue background to represent | - -

the sea

All map layers were imported from City and County of San Francisco GIS data (San Francisco Enterprise GIS program
SFGIS) in ESRI shapefile format and cropped to the area of interest. The map design (symbols and line styles) was
created by Avenza Systems.

1.2.2 Styles and rules

MAPublisher is installed with predefined styles and rules to use for the MAP LabelPro settings in this tutorial. These
configuration files are saved to one of three folders depending on the data type layer, | &| Area, || Line or | I’ | Point,
they are associated with.

Layer Name Type Style Rule

\LabelPro\Styles \LabelPro\Rules
Public_Schools_point Point School_Label_Style School_Label_Rule
Interstates_line Line Interstate_Label_Style Interstate_Label_Rule
Highways_line Line Highway_Label_Style Highway_Label_Rule
Streets_line Line Street_Label Style Street_Label Rule
Parks_area Area - -
Land_area Area Land_Label_Style Land_Label_Rule

The style and rules for the Parks_area layer will be created during the second labeling session of this exercise.
The default location of the Rules and Styles folders is:

Windows XP: C:\Documents and Settings\All Users\Application Data\Avenza\MAPublisher 9\LabelPro\Rules
Windows Vista: C:\ProgramData\Avenza\MAPublisher 9\LabelPro\Rules
Mac OS X: Applications/Avenza/MAPublisher 9/MAPublisher Plug-In/LabelPro/Rules

Note: The MAP LabelPro tutorial data folder also contains a backup for these rules and styles

1.2.3 Important note for MAPublisher LabelPro evaluation users

The evaluation version of MAPublisher LabelPro scrambles the text of placed labels but preserves the case,
spacing and punctuation so that it simulates how actual labels would be placed. Therefore, evaluation users will
experience a different result with the MAP LabelPro settings of this tutorial than licensed users. The results will be
shown and differences explained at the end of this guide. In evaluation mode, the scrambling process noticeably
slows the speed of labeling.

é MAPublisher 9 LabelPro Tutorial
1 Preliminaries



2 Getting Started

2.1 Open tutorial document

1. Inthe Adobe Illustrator main menu, choose File> Open and open the template file MAPLabelPro_Tutorial.ait located

in \MAPublisher 9\MAP LabelPro Tutorial Guide & Data\Data.
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An artboard containing a map of San Francisco opens. All the data information to be used for labeling is present,
except for the text labels. Please see the table in the Preliminaries chapter for the description of the layers.

2. Because the file was opened from a template, a new untitled document was created. Choose from the Adobe
lllustrator main menu File > Save As to save the file as San Francisco.ai.

Note: Customize the Adobe lllustrator workspace to make it easier to access panels. It may look different than

the image above. Read Customizing the workspace in the Adobe lllustrator help guide for more information.

Review also MAPublisher Preferences in the MAPublisher 9 User Guide.

2.2 Examine MAP Attributes available for labeling

MAP LabelPro extracts label data from the attribute table for each MAP Layer to be labeled. Therefore, it is good
practice and often required to examine or edit attribute information using the MAP Attributes panel. Edits can
include: creating a new column to enter attribute values, joining tables to import additional attribute information
from an external file, correcting spelling, changing the case of text and more.

For this exercise, all attributes are ready to use for labeling. Follow the steps here to examine them and familiarize
yourself with the data.

Note: For more information on the MAP Attributes panel, please refer to the MAPublisher 9 User Guide, chapter 5.

For more exercises, please see the MAPublisher Quick Start Guide and MAPublisher Tutorial Guide.

MAPublisher 9 LabelPro Tutorial
2 Getting Started
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1. Inthe Adobe Illustrator Layers panel, click the target button @ next to the Public_Schools_point layer to select
all artwork on the layer.

2. Open the MAP Attributes panel (from the Adobe Illustrator main menu, choose Window > MAPublisher> MAP
Attributes or click the MAP Attributes button on the MAPublisher toolbar [E]).

The Public_Schools_point layer contains four visible attribute columns: OBJECTID, FACILITY_l, DEPTNAME and
SCHOOL_NAME. The SCHOOL_NAME attribute column will be used for labeling the school points.

MAP Attributes

Layer: ‘ Public_Schools_paint {24 points selected) | - ‘ -
[1]OBIECTID [E]FACILITY_I [5]DEPTNAME [5]5CHOOL_NAME

1 1,913 0000003094 SF Unified School District (SFUSD) | FRANCISCO MIDDLE SCHOOL

2 1,914 0000003095 SF Unified School District (SFUSD) | YICK WOOQ SCHOOL

3 1,915 0000003096 SF Unified School District (SFUSD) | GARFIELD SCHOOL

E 1,919 0000003102 SF Unified School District (SFUSD) | JEAM PARKER SCHOOL

5 1,920 0000003104 SF Unified School District (SFUSD) | SPRING VALLEY SCHOOL

6 1,922 | 0000003106 SF Unified School District (SFUSD) | CHINESE EDUCATION CENTER

23points seected 5 i DO /0BT

3. Selectall artwork on the Interstates_Line layer and view the attributes in the MAP Attributes panel.

MAF Attributes

Layer: ‘ Interstates_line (4 lines selected) |. ‘ o
[S|STREETNAME | [T]INTERSTATE_NUMBER

1| VAN NESS AVE 101

2| VAN NESS AVE 101

3| LOMBARD ST 10

4|LOMBARD 5T 10

4lines selected EEH Six) BE

The INTERSTATE_NUMBER attribute column will be used for labeling these roads.

Note: Notice that the INTERSTATE_NUMBER attribute is of type integer [I]. All types of attributes may be used for
labeling with MAP LabelPro.

4. Select all on the Highways_line layer and view the attributes in the MAP Attributes panel. HIGHWAY_NUMBER
will be used for labeling. View the attributes of the remaining layers: Streets_line, Parks_area, and Land_area.

Refer to the San Francisco description table in section 1.2.1 to see the attributes that will be used for labeling.
5. Close the MAP Attributes panel after reviewing it.

Knowing this information, we are ready to use the MAP LabelPro function to generate map labels for the San
Francisco downtown map.

8 MAPublisher 9 LabelPro Tutorial
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3 Labeling Session #1

In this first labeling session, multiple layers will be labeled in a single run of the MAP LabelPro function. The
objectives for this session are to:

Add labels for school as a first priority (source layer Public_Schools_point).

Label the interstate roads with interstate shield symbols containing the interstate number (source layer
Interstates_line).

Label the highway roads with highway shield symbols containing the highway number (source layer
Highways_line).

Add street names (source layer Streets_line).

Add names for land areas, written in the sea to make the map more readable (source layer Land_area).
Make sure that the school and road names do not overlap with the post office and school symbols and park
area, and do not cross highways and interstates line (obstacle layers: Post_Offices_point, Public_Schools_
point, Parks_area, Interstates_line and Highways_line).

To start the MAP LabelPro Editor, click the MAP LabelPro button on the MAPublisher Toolbar.

Dats Crastion Thamasic Took Lagand Tosls

tmpart/aport Pragars Gacproceming Orgasizaten Labals
HEEERT IO0OF E OYyed v/ HOeor BAY CoB% WDH <o Ao

MAP LabelPro

The MAP LabelPro dialog box opens.

MAP LabelPro

Source Attribute Destination Priority Style Rules Suppression Layer Save &Label

Save

Setup Layers..

Advanced...

]

Obstacle Layers: Source Art:

@ Label all art on source layers

_ Import Settings...
[ —
Export Settings...

All layers have to be configured before labeling with MAP LabelPro. The general MAP LabelPro workflow: setup
source layers, specify attribute to be labeled, set label destination or suppression layers, set label priority and define
layer styles and rules.

If the dialog box needs to be closed before all configurations are done, make sure to click the Save button. If
labeling has been executed and an Undo action is used afterwards, the configurations in MAP LabelPro will revert
to the configuration before the labeling was executed. To ensure that your configuration is saved, click the Save
button before labeling.

MAPublisher 9 LabelPro Tutorial 9
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3.1 Layers and obstacles setup

1. Inthe MAP LabelPro editor dialog box, click the Setup Layers button.
2. Inthe Setup Layers dialog box, click the Label check box for each of the following layers to enable them as
source layers:
«  Public_Schools_point
« Highways_line
+ Interstates_line
+  Streets_line
+ Land_area
3. Click the Obstacle check box for each of the following layers to enable them as obstacle layers:
«  MAP_TITLE
- Post_Offices_point
«  Public_Schools_point
« Highways_line
+ Interstates_line
+ Parks_area

Setup Layers
MName Label Obstacle OK
4 @ San Francisco Downtown
i HIGHWAY_INTERSTATE_|abels =
[T] LAND_labels (]
[T| map_TITLE B
IT| PARK labels B
IT| SCHOOL labels B
[T STREET labels B
SUPPRESSED._labels B
I’ Post_Offices_point =
'] Public_Schools_point
[L] Highways_line
IL] Interstates line
[L| Ramp_line ] B
[L] streets line B
[A] background B B
[A] Land_ares B
[&] Parks_area ]

4. Make sure that the settings match the image above and click OK.

The MAP LabelPro dialog box gets updated according to the layers settings. Selected layers for labeling are
added to the Source list and selected layers for obstacles are added in the Obstacle layers list.

10 | MAPublisher 9 LabelPro Tutorial
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MAP LabelPro

Source Destination Pricrity Style Rules Suppressicn Layer
4 @ San Francisco Downtown
| Public_Scheols_point [S] FACILITY_I HIGHWAY IN... 1 [Default] [Default] [ [ignered]
ighways_line HIGHWAY IN... 1 [Default] [Default] [ gnored]
terstates_line HIGHWAY IN... 1 [Default] [Default] [ gnored]
reets_line STREETNAME HIGHWAY IN... 1 [Default] [Default] 2 Hgnored]
Land_srea AREA_NAME HIGHWAY IN... 1 [Default] [Default] 2 lgnored]
Obstadle Layers: Source Art:

4 0 San Francisce Downtown
| Post_Offices_point
| Public_Schools_point
Highways line
Interstates_line
Parks_area

@ Label all art on source layers

) Label only selected art on source layers

Save &label
Save

Cancel

Setup Layers..

Advanced...

Import Settings...

LR

Export Settings...

3.2 Labeling extents setup

The configuration described in this exercise will limit the creation of labels to the extent of the selected source
layers for labeling, with a margin of 0.2 inches on each side.

1. Click the Advanced button in the MAP LabelPro dialog box.
2. Under Label Placement Area, choose the Extents of labeled layers option.
3. Click the Label Margins check box. Set the Top, Left, Right and Bottom drop-down lists to 0.20 in.

Note:

used as an obstacle in the labeling process, allowing generated labels to overlap with them.

Advanced

Label Placement Area:
() Extents of the current artboard

@ Extents of labeled layers

Label Margins:

Top: 0.20in <

Leftt  0.20in 2

Right:  0.20in <

Bottom: |0.20in i

Obstacles:

|} Paths without stroke are not considered
obstades

4. Make sure that the settings match the image above and click OK.

The label styles and rules of each source layer are now ready to be set.

MAPublisher 9 LabelPro Tutorial
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3.3 Point layer label settings

1. Inthe MAP LabelPro editor dialog box, click Public_Schools_point in the Source column to highlight the row.

By default, the attribute to use as a label is set to FACILITY_|, the first string attribute column of the
Public_Schools_point layer. It needs to be changed to SCHOOL_NAME.

Note: Increase the width of an attribute column to see its full name.

2. Click FACILITY_I in the Attribute column. This enables a drop-down list with all the attributes of the
Public_Schools_point layer. Choose SCHOOL_NAME from the drop-down list.
3. Inthe Destination column, choose SCHOOL_labels from the drop-down list.

Source Attribute Destination Priority Style Rules Suppre *
4 0 San Francisco Downtown
Public_Schools_point [EIEEsSa VAN (1] SCHOOL labels UMMM D = ) (ignor| =
Highways_line STREETNAME HIGHWAY INTE... 1 [Default] [Default] 2 ligner
Interstates_line STREETMAME HIGHWAY_INTE... 1 [Default] [Default] A ligner
Streets_line STREETMAME HIGHWAY_INTE... 1 [Default] [Default] A ligner -
4 n ] b

Leave the Priority column set to 1. The Public_Schools_point layer will be labeled as a first priority while the
others will be set to a secondary priority.

4. In the Style column, click [Default] and choose School_Label_Style from the drop-down list. Click the Edit button
[.=_|to open the Style dialog box and examine its settings. This style was predefined.

Source Attribute Destination Priority Style

Rules Sup *
4 @ San Francisco Downtown
Public_Schools_point [EIEEa e MU ] SCHOOL labels | School Label Style + . (3¢ 2] A=
Highways_line 5] STREETNAME HIGHWAY INTE... 1 [Default] p [Default] g
Interstates line (5] STREETNAME HIGHWAY INTE... 1 [Default] (Default] A
Streets_line [E] STREETNAME HIGHWAY_INTE... 1 [Default] [Default] Ag -~
[ i | ’
Style I
Family: [ T Verdana 'I [ ok }
Style: [Bold - oo ]
Size:  6.00pt [=
coour: [
Opadty: i D. 100%[%

Note: The second labeling session will show how to create a new style from scratch.

5. After reviewing the Style settings, click OK to close it.
6. Inthe MAP LabelPro dialog box, under the Rules column, click [Default] and choose School_Label_Rule from the

drop-down list. Click the Edit button [.."| to open the Point Rules dialog box and examine its settings. This style
was predefined.

12 | MAPublisher 9 LabelPro Tutorial
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Source Attribute Destination Priority Style Rules Sup

4 e San Francisco Downtown

P Public_Schools_point [EIEEa (e M0 3 (1] SCHOOL labels % TNl School_Label Rule ~ (7)) A (1=

L] Highways_line 5] STREETNAME [ HIGHWAY INTE... 1 [Default] [Default] ) P

Interststes line [5] STREETNAME  [T] HIGHWAY INTE... 1 [Default] [Default] A

Streets line STREETMAME HIGHWAY INTE... 1 [Default] [Default] A~
n L3

Point Rules I

Placement

[¥] Allow stacking |Up to 4lines =

Ci
= = o
@ o
3 2 [T] Allow labels to cross lines

New
i Yo
ocy
Select positions in order of priority.

Allow font reduction

Unsslected positions wil not be tried. A
Steps: 4 -

[] Centered on point A
Esch m=p sbows LabelPro w shink the |

ssiecued fomt by 0.5 p, # necessary

[T Allow use of leader lines
New Village [] Allow overlapping labels
Allowed Line Crosses: |3 %
New -
Leader Width: 1.00pt bt @ Citya)

100

Arrow Style: Style #1

These point settings will force the labels to be placed below the symbols:

+ When possible, the text will be placed lower-middle to the symbol.

« If this is not possible due to space constrictions, text will be placed to the lower-right, and then to the lower-left.

« If none of the options can be applied, the text will be placed on the suppression layer (or ignored if no
suppression layer was specified).

« Text stacking and font reduction have also been enabled to add flexibility to the placement rules.

Note: More information on the available labeling options can be found in the MAPublisher User Guide, chapter 17.

7. After reviewing the Point Rules dialog box, click OK to close it.
8. In the Suppression Layer column, click the text [Ignored] and choose SUPPRESSED _labels from the drop-down list.

Labels that can not be placed will be copied to the SUPPRESSED_labels layer.

Note: Scroll to the right of the MAP LabelPro dialog box or expand it to see the Suppression Layer column.

This finalizes the configuration for the labeling of the Public_Schools_point layer. Do not close the MAP LabelPro
dialog box as the configuration of the roads and land layers still have to be set. If you want to save the current
configurations, click the Save button. You will have to reopen the MAP LabelPro dialog box to continue.

MAPublisher 9 LabelPro Tutorial | 13
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3.4 Line layers label settings

This section covers the labeling configuration for the source layers Highways_line, Interstates_line and Streets_line.
Highways and interstates will be labeled using highway and interstate symbol shields—notice that these layers
contain double-lines for each road (divided highways).

3.4.1 Label lines with symbols

A wWN =

14

In the MAP LabelPro dialog box, click the Highways_line layer name in the Source column to highlight the row.
In the Attribute column, choose HIGHWAY_NUMBER from the drop-down list.

In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).
Set the Priority column to 2.

In the Style column, choose Highway_Label_Style from the drop-down list. Click the Edit button to open the
Style dialog box and examine its settings. This style was predefined.

Style
Family: [ T Verdana v] [ oK J
Style: |Reguiar =] [ concal
Size:  10.00pt/=
= ==
Opacity: ) 100% B
Label with symbol
Symbol File: | generic_shields.lsf -
Symbol: @ United States Interstate ~ | Height:  0.25in %

In addition to the regular font settings, line labels can also be labeled with symbols. In this case, the Label with
symbol option is enabled. Symbol files (*.Isf) contain a series of symbols. In the example above, the United States
Interstate symbol is selected from the generic_shields.Isf symbol file. The symbol size is set to a height of 0.25
inches. The symbol font color is set to white so it can be legible against the blue symbol.

After reviewing the Style settings, click OK to close it.
In the MAP LabelPro dialog box, in the Rules column, choose Highway_Label_Rule from the drop-down list. Click
the Edit button [ .| to open the Line Rules dialog box and examine its settings. These rules were predefined.

MAPublisher 9 LabelPro Tutorial
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With these settings, the highway labels (and shields) will be placed in the middle of each line length and on the
centerline, with a font reduction (if necessary). The Divided Highways setting recognizes lines that are parallel
and share the same name (as specified by the selected attribute). In such cases, it places only one symbol
instead of two or more. The Allow labels to cross lines option needs to be enabled because double highway
lines are very close in proximity and the labels need to cross the lines. More information on line labeling rules
can be found in the MAPublisher 9 User Guide, chapter 17.

Note: Evaluation users will see a different result than a licensed user. Because of the text scrambling, the divided
highways cannot be recognized. Here is an example with the interstates:

Result with license: F‘ijegult with evaluation:

W] Ar

8. After reviewing the Line Rules settings, click OK to close it.
9. Inthe MAP LabelPro dialog box, in the Suppression Layer column for Highways_line, choose SUPPRESSED_labels
from the drop-down list.

The settings for the Highways_line layer are completed. Continue with the settings for the Interstates_line layer.

10. Click the Interstates_line layer name in the Source column to highlight the row.
11. In the Attribute column, choose INTERSTATE_NUMBER from the drop-down list.
12. In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).

MAPublisher 9 LabelPro Tutorial | 15
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13. Set the Priority column to 2.
14. In the Style column, choose Interstate_Label_Style from the drop-down list. Click the Edit button [.."| to open the
Style dialog box and examine its settings. This style was predefined.

Style
Family: [ T Verdana vl [ oK J
Style: |Regular - —
Size:  10.00pt/
colour: [l
Opacity: ) 100% B
Label with symbol
Symbol File: | generic_shields.lsf -
Symbol:  United States Route | Height: 0.25in |=

The United States Route symbol is selected from the generic_shields.Isf symbol file. The symbol size is set to a
height of 0.25 inches.

15. After reviewing the Style settings, click OK to close it.
16. In the MAP LabelPro dialog box, in the Rules column, choose Interstate_Label_Rule from the drop-down list. Click
the Edit button [_._| to open the Line Rules dialog box and examine its settings. These styles were predefined.

The labeling rules for the interstates are the same as for the highways. The previous note applies for evaluation
users.

17. After reviewing the Line Rules settings, click OK to close it.
18. In the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list.

The label settings for the interstate roads are now complete. Continue with the street labels.

3.4.2 Label lines with text only

1. Inthe MAP LabelPro dialog box, click the Streets_line layer name in the Source column to highlight the row. Keep
STREETNAME as the selected attribute for labeling.

2. Inthe Destination column, choose STREET_labels from the drop-down list.

Set the Priority column to 2.

4. Inthe Style column, choose Street_Label_Style from the drop-down list. Click the Edit button to open the
Style dialog box and examine its settings. This style was predefined.

w
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Style

Famiy: | i Verdana v][ oK J
Style: [Bold -] (i)
Size:  6.00pt =

Colour: . e
Label case:

opadty: < D. 100% |+

[ Label with symbol
Symbol File: -

Symbol: ~ | Height: Auto

Notice that this time Label with symbol is not checked.

5. After reviewing the Style settings, click OK to close it.
6. Inthe MAP LabelPro dialog box, in the Rules column, choose Street_Label_Rule from the drop-down list. Click the
Edit button [..| to open the Line Rules dialog box and examine its settings. These rules were predefined.

Line Rules.
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e
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4] Mlow ot reciacnon

sarps: 4 : AA

B Lobal yoned feature o Lt 1 shrck o suivcins | ]
fom ey 0.5 g # recewary
Laiel each feature
e e of leade fres
_\“'-h
SRy e
-
HET:
A averlaoorng labels. | §
Sgread words
o
- e tvng,

Like highway and interstate labels, street labels will be placed in the middle of each line length and on the
centerline, with an eventual font reduction if necessary. The ability to overhang is enabled here.

The street lines in this file are not joined. For example, each street is made of many line segments that all share
the same STREETNAME attribute. To avoid repeating the name of connecting lines, the Label joined feature rule
is enabled. MAP LabelPro recognizes that connecting lines sharing a same name need to be labeled only once.

Note: Evaluation users will see a different result than a licensed user due to the text scrambling. Names are not
recognized as being the same and labels will be created for each line segment rather than one per street.
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Result with license: Result with evaluation:
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7. After reviewing the Line Rules settings, click OK to close it.
8. Inthe MAP LabelPro dialog box, in the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list.

This completes the label settings for all line layers. Do not close the MAP LabelPro dialog box as the configuration
of the Land_area layer still has to be done. If you want to save the current configurations, click the Save button. You
will have to reopen the MAP LabelPro dialog box to continue.

3.5 Area layer label settings

This section covers the labeling configuration for the source layers Land_area. The goal is to add large labels for the
land areas of the map (downtown area, Treasure and Alcatraz Islands).

1. In the MAP LabelPro dialog box, click the Land_area layer name in the Source column to highlight the row. Keep
AREA_NAME as the selected attribute for labeling.

2. Inthe Destination column, choose LAND_labels from the drop-down list.

Set the Priority column to 2.

4. In the Style column, choose Land_Label_Style from the drop-down list. Click the Edit button [ | to open the
Style dialog box and examine its settings. This style was predefined.

w

Style

Famiy: | o Aria - o ]
Style: [Regular - Cancel J

size:  70.00ptll [ ™
Save As..

Label case: |Leave asis -

Opadty: S 1) 100m[E]

Note: The sample text in the preview is cut off because the font size is set to 70 pt.

5. After reviewing the Style settings, click OK to close it.
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6. Inthe MAP LabelPro dialog box, under the Rules column, choose Land_Label_Rule from the drop-down list. Click
the Edit button [.__|to open the Area Rules dialog box and examine its settings. These rules were predefined.

Area Rules

Placement

[¥] Allow stacking |Up to 3lines = 5
[ e b e — oy

[] Allow dominant angle Cly Park Save As...
B :Huwdexnendmg beyond [7] Allow labels to cross lines
oundary \‘Qt

[¥] Allow outside

Allow inside, along
a boundary

Allow font reduction

Steps: 4 - AA

[] Allow use of leader lines

 New Village Each siep slhows LabelPro to shrink the | A
Allowed Line Crosses: |3 : selected font by 0.5 pt, i necessany
Leader Width: 1.00pt =

" Syl Siyle #1 [] Allow overlapping labels
Arrow Style: Style #1  ~

The main requirement for labels created from the Land_area layer is that labels are placed in the water area.
Therefore, the Allow outside rule is the only placement option enabled. Stacking and font reduction option are
also enabled to give more flexibility to the rule. More information on the available area labeling rules can be
found in the MAPublisher 9 User Guide, chapter 17.

Note: Labeling Session #2 will explain the creation of area rules for the Parks_area layer.

7. After reviewing the Area Rules settings, click OK to close it.
8. Inthe MAP LabelPro dialog box, in the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list.

All layers have been now configured for the first labeling session.
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3.6 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured to match the image below and click the Save & Label button.

MAP LabelPro
Source Atribute Destination Priority Style Rules Suppression Layer Save &Label
4 |@ San Francisco Downtown
| Public_Schaols_point [5] SCHOOL_MAME SCHOOL labels 1 School Label Style  School_Label Rule SUPPRESSED_labels

Highways line [T] HIGHWAY_NUMBER
nterstates_line [E] INTERSTATE_NUMBER

IGHWAY INTERSTATE labels 2 Highway_Label Style Highway_Label Rule [T SUPPRESSED labels

IGHWAY INTERSTATE labels 2 Interstate_Label Style Interstate Label_Rule [T SUPPRESSED labels

treets_line STREETMAME TREET labels 2 Street_Label Style  Street_Label_Rule SUPPRESSED labels
Land_area AREA_NAME LAND_labels 2 Land_Label_Style Land_Label_Rule SUPPRESSED _labels
Advanced...
Obstadle Layers: Source Art:
4 (@ Label al art on source layers
@ San Francisco Downtown : e
I’| Post_Offices_point () Label only selected art on source layers

| Public_Schaols_point
Highways_line
Interstates_line
Parks_area

Note: For this session, the other labeling options will be kept as default:

+  Source Art: option to label all the source layers or label only the selected art on each source layer. In the
example above, all objects will be labeled exactly as found in the source attributes.

«  Options: statistics type option displays a report on placed and non-placed objects. It will be used in the
Labeling Session #2. For this example, the option is set to None.

Note: For evaluation users only. Review the MAPublisher warning message and click OK to close it.

i The Evaluation version of Label Pro scrambles the text of placed labels but preserves the
\\) case, spacing & punctuation so that the results give a sense of how actual labels would
be placed.

Please also note that Unicode & foreign glyphs are mapped on to standard Latin
characters when the labels are scrambled, but are fully supported in the licensed version

of LabelPro.

2. Wait for the process to end to visualize the results (see next page).

The map layers are labeled. Make the SUPPRESSED_labels layer visible to show labels that couldn't be placed
with the specified rules.

3. Save the file and leave it open to continue on with the second labeling session.
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Result with full license:

Note:

Evaluation users will observe scrambled labels on the map. The Label joined feature rule does not recognize
similar street names due to the text scrambling and places more labels than necessary. Similarly, highway
and interstate roads are labeled with two shields with different numbers. Licensed versions will not see any

text scrambling.
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4 Labeling Session #2

In this second labeling session, continue with the San Francisco.ai file that you saved. This time, only the parks will

be labeled in a single labeling execution of MAP LabelPro. The objectives are to:

+ Create a new area label style for park labels.
«  Create a new area label rule for park labels.

« Make sure that the park labels do not overlap with the other labels and with the post office and school

symbols, and do not cross highway and interstate lines.

To start MAP LabelPro, click the MAP LabelPro button on the MAPublisher Toolbar. The settings from the previous
labeling session are remembered. For the new session, the layer setup has to be changed to match the new

objective of this exercise. However, the label extents remain the same as before.

4.1 Layers and obstacles setup

1. Inthe MAP LabelPro Editor, click the Setup Layers button to setup the source and obstacle layers.
2. Inthe Setup Layers dialog box, click the very top Label check box (at the level of the San Francisco Downtown

MAP View). Click the check box again to uncheck all of the Label check boxes.

3. Click the Label check box of the Parks_area layer only.

4. Make sure that only the following layers are set as obstacles:

« HIGHWAY_INTERSTATE_labels
+  SCHOOL_labels

«  STREET_labels

- Post_Offices_point

«  Public_School_point

« Highways_line

« Interstates_line

Setup Layers

MName

4 @ San Francisco Downtown
HIGHWAY_INTERSTATE labels
LAND_labels
MAP_TITLE

PARK labels
SCHOOL labels
STREET labels
SUPPRESSED._labels
Post_Offices_point
Public_Schools_point
Highways_line
Interstates_line
Ramp_line
Streets_line
background
Land_area

EEEEEEEEFEEEEEEE

i

Parks_area

Label Obstacle

OooooooO
L0000 0EEREO0EESO0ORE

Cancel

5. Make sure that the settings match the image above and click OK.

The MAP LabelPro dialog box is updated with the new selected layer setup.
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MAP LabelPro

Source Autribute Destination Pricity style Rules Suppression Layes | | Save Blabel |
4 @ San Funcics Dowedown '—M
(&1 Parks_area [ LaND D O HIGHWAY INTERSTATE labeks 1 [Default] [Default] B ngrared] | p——
| Cancel |
| | Sehup Layers..
[ advanced... |
Obstacke Layers: Source Art:
| 4 @ Sen Francisco Downtown & Latbel ol arkt o source s gt Seebtings... |
[T rGHWAY BNTERSTATE Jabels Lsbel oy sesecled an1 on sowce layers. =
[T SCHOOL Lebiets |Erpunt Settrgs...
[A] STREET labels
P! Post Offices_paint
P! Pubis_Schuols_poml
|1 Highways_line
(L] Interstates line

4.2 Additional area layer label settings

This section covers the labeling configuration for the source layer Parks_area. The goal is to add labels for the parks on
the map, allowing the use of leader lines and font reduction. In this exercise, style and rules are created from scratch.

© No A

In the MAP LabelPro dialog box, click the Parks_area layer name in the Source column to highlight the row.
In the Attribute column and choose PARK_NAME from the drop-down list.
In the Destination column, choose PARK_labels from the drop-down list.

Source Attribute Destination Priority Style Rules Suppression Layer

4 @ San Francisco Downtown

Parks_area [|SMYGUE Y] PARK_labels a1 [Default] [Default] [A [ignored]

In the Style column, click [Default] and then click the Edit button [ .. | to open the Style dialog box.

Make sure that Arial is selected in the Family drop-down list.

Make sure that Regular is selected in the Style drop-down list.

In the Size drop-down list, set the font size to 7.00 pt

Click the color chip and in the Color Picker dialog box, pick dark green color (e.g. R=0, G=85, B=0) and click OK.

Caolor Picker

Select Color:

A&
|
o ance
B (Color Swatches
@H 120 *
@s: 100 %
@p: 33 %
D.<1 ©R: 0 C 85
G 8 M 40
©B 0 ¥: 100
b . = 005500 K: 40

| Eonty web colars i

® R ® R
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9. Make sure that the Style dialog box is setup as below and click Save As.

Style
Famiy: | m Aria - x|
Style: |Regular -][ﬁmm‘
Size:  7.00pt &

coour: [

omcty 4 womE

10. In the Save As dialog box, type Park_Label_Style in the Name box and click Save.

Save As

Name: Park_Label_Style - o

11. In the Style dialog box, click OK to close it.

Source Attribute Destination Priority Style Rules Suppressig

4 e San Francisco Downtown

LRI Bl PARK_NAME PARK _labels 1 Park_Label_Style [ ) (30 JREEN [A [Ignored]

In the MAP LabelPro dialog box, the Style column now displays the text Park_Label_Style. The style is saved in
the directory specified in the MAPublisher Preferences.

12. In the MAP LabelPro dialog box, under the Rules column, click [Default] and then click the Edit button [ .| to
open the Area Rules dialog box.

13. In the Area Rules dialog box, under Placement, click the check box for Allow extending beyond boundary.

14. Click the checkbox for Allow use of leader line. Keep the default parameters.

15. For the Allow stacking rule, choose Up to 4 lines from the drop-down list. Leave the alignment as Feature.

16. Click the check box for Allow labels to cross lines to disable the rule.

Asea Rules
Flacement - X
| Mo stacking |Uptodines - || B
7! Alow herizontal insde Abgrment: Feanse  +
A demeant angie
o) Mo exiending beyend Alow kel 1 ros3 s

N anisde
| S—————.
Ao e, shorg
bondry
| Allow font reducion
Steps: 4 . A
| Ao use of leads s - Al
__52-:: ik s slowy Ll = gheek e | A
Aloverd Line Crenes: 3 2 sawied bt Iy 8.5 gL ¥ reuminacy
Leader Wdth: 100t il
St e— PER N
Artow Styles Sty sl v
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17. Click the Save As button and in the Save As dialog box, type Park_Label_Rule in the Name box and click Save.

Save As

Name:  Park_Label Rule - e

18. In the Area Rules dialog box, click OK to close it.
19. In the Suppression Layer column, choose SUPPRESSED _labels from the drop-down list.

Source Attribute Destination Priarity Style Rules Suppression Layer

4 @ San Francisco Downtown

Parks_area PARK_MAME PARE_labels 1 Park_Label_Style Park_Label Rule SUPPRESSED_lal

In the MAP LabelPro dialog box, the Rules column now displays the text Park_Label_Rule. The rule is saved in the
directory specified in the MAPublisher Preferences.

4.3 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured as below and click the Save & Label button.

MAP LabelPro
Source Attribute Destination Priority Style Rules Suppression Layer Save &Label
4 @ SanFrancisco Downtown
Parks_area PARK_MAME PARK _labels 1 Park_Label_Style Park_Label_Rule SUPPRESSED_labels
Obstacle Layers: Source Art:
4 @ SanFrancisco Downtown @ Label all art on source layers
IGHWAY_INTERSTATE labels () Label only selected art on source layers
CHOOL labels Expogheetingey
STREET_labels
| Post_Offices_point
| Public_Schaols_point
Highways_line
Interstates_line

The parks are labeled appropriately according to the style and rules defined in MAP LabelPro.
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2. Click the MAPublisher Log button on the MAPublisher Toolbar.

N
umtier g L e
Message When Layer
4 k3 LabelPro i i2 minutes age
&# Starting label generation
&9 Finiched label generation -Dﬁd Al
% Placing generated labels 2 minutes ago -
&9 Layer ‘Parks_area’: 44 label(s) were placed
&9 TOTAL: 44 label(s) were placed p—
& & LabelPro labeling session 19 minutes ago -
snov: (@) [ @)
=\

Statistics about how many labels were placed (or not placed) on each layer are displayed in the log. Notice that
the first labeling session is also listed.

3. After reviewing the statistics, click Close to close the MAPublisher Log dialog box.

Result with full license: Result with evaluation license:

Congratulations, you have completed the MAPublisher 9 MAP LabelPro tutorial. For more in-depth information
on MAPublisher tools and features, please take a look at the MAPublisher 9 User Guide , MAPublisher 9 Tutorial
Guide and Quick Start Guide. These documents are installed with MAPublisher or can be downloaded from
http://www.avenza.com/documentation.
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